Spatial Analysis Exercise
GIS in Water Resources
Fall 2011

Prepared by David G. Tarboton and David R. Maidment

Goal

The goal of this exercise is to serve as an introduction to Spatial Analysis with ArcGIS.
Objectives

e Calculate slope from a grid digital elevation model

o Apply model builder geoprocessing capability to program a sequence of ArcGIS functions

e Use raster data and raster calculator functionality to calculate watershed attributes such as mean
elevation, mean annual precipitation and runoff ratio.

e Interpolate data values at points to create a spatial field to use in hydrologic calculations

Computer and Data Requirements

To carry out this exercise, you need to have a computer, which runs the Arcinfo version of ArcGIS 10.
The necessary data are provided in the accompanying zip file,
http://www.ce.utexas.edu/prof/maidment/giswr2011/Ex3/Ex3.zip

Readings

Handout on "Computation of Slope" http://www.ce.utexas.edu/prof/maidment/giswr2011/docs/Slope.pdf



http://www.ce.utexas.edu/prof/maidment/giswr2011/Ex3/Ex3.zip
http://www.ce.utexas.edu/prof/maidment/giswr2011/docs/Slope.pdf

Part 1. Slope calculations

1.1 Hand Calculations

Given the following grid of elevations. Calculate by hand the slope and aspect (slope direction) at the grid
cell labeled A using

Q) The standard ESRI surface slope function (see lecture 7 slides 48-50 in Spatial.ppt)

(i) The 8 direction pour point model (see lecture 7 slides 51-52 in Spatial.ppt)

Refer to the powerpoint slides (http://www.ce.utexas.edu/prof/maidment/giswr2011/Visual/Spatial.pptx )
from lecture 7 to obtain the necessary formulas for each of these methods. Refer also to the "Computation
of Slope" readings for a deeper understanding of slope.

Grid cell size 10m

106.5 106.5 106.2 108.4 107.8
107.4 106.8 107.2 A | 108.1 108.1
109 108.3 109 B 111 108.1
108.1 107.8 108 108.7 108.9

Comment on the differences and indicate which you think is a better approximation of the direction of
water flow over the surface.

To turn in: Hand calculations of slope at point A using each of the two methods and comments on the
differences.

1.2 Verifying calculations using ArcGIS
Verify the calculations in (1.1) using ArcGIS Hydrology and Surface Toolbox functions.

Save the following to a text file 'elev.txt' (This file is also included in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2011/Ex3Data.zip)

ncols 5
Nnrows 4
xllcorner 0
yllcorner 0
cellsize 10

NODATA value -9999

106.5 106.5 106.2 108.4 107.
107.4 106.8 107.2 108.1 108.
109 108.3 109 111 108.
108.1 107.8 108 108.7 108.

O = =

This shows how raw grid data can be represented in an ASCII text format that ArcGIS can import.
Knowing how to get raw information into a form where it can be imported and analyzed using GIS is a
useful skill.

Open ArcMap and ArcToolbox. Use the tool Conversion Tools = To Raster - ASCII to Raster to
import this grid file into ArcMap. Specify the name of the Output raster as elev.tif and give it a disk
location. (Note that the extension specifies the grid file format, .tif for a TIFF file, .img for an ERDAS
IMAGINE file, or no extension for an ESRI GRID raster format.) Specify the Output data type as FLOAT
because the given elevation data includes decimal values.


http://www.ce.utexas.edu/prof/maidment/giswr2011/Visual/Spatial.pptx
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2011/Ex3Data.zip
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You can use the identify button on the grid created to verify that the numbers correspond to the values in
the table above.

il N g = ":"El'u

-
@ Untitled - ArcMap - Arclnfo R — ? o [R— .

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

OBE& LEExoc - - EEEE0 &
QaQU@iill« -0/ k@ E&NAESE Y

Table Of Contents 1 x
Identify
l Identify from: I <Top-most layers> ;I
El-elev

308 1
-~ 109,000000
A— Eﬂ?

= = layers
N
Location: 25,519 MUnmwn Units

+ ArcToolbox T x
90 Conversion Tools -
& From KML
(-8 From Raster
-8 From WFS
By Metadata
& ToCAD
% Te Collada
-8 To Coverage
-8 To dBASE
-8 To Geodatabase
B ToKML
=] % To Raster
X ASCI to Raster
"& DEM to Raster
‘& Feature to Raster =|
‘& Float to Raster
L.#%, Point to Raster
X Polygon to Raster
'& Polyline to Raster
-5/ Raster To Other Forn
-8 To Shapefile
-9 Data Interoperability Tools
-8 Data Management Tools
By Editing Tools
- Geocoding Tools
& Geostatistical Analyst Tools —
& Linear Referencing Tools
-89 Multidimension Tools
B3 Metwork Analyst Tools
A &89 Parcel Fabric Tools
¥ & Schematics Tools 2
@@ | e n < m | » ] mn
12,619 43.21 Decimal Degrees

[queas 1] ]

= W

Value
High:111

Low :106.2

Field Value
Stretched value 179

Pixel value 109.000000

Identified 1 feature

m

Open Customize = Extensions and verify that the Spatial Analyst function is available and checked.
This is where the spatial analyst license is accessed, so if Spatial Analyst does not appear you need to
acquire the appropriate license.
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The resulting Slope grid should be added to the display. Use identify to verify your hand calculation for
grid cell A and note the value of slope for grid cell B.



Open the tool Spatial Analyst Tools 2 Surface > Aspect. Select elev as the Input raster and specify a
name for the output raster (e.g. Aspect). Click OK.

Input raster
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direction of the aspect.

-

] [ Cancel ] [Environments... ] [ << Hide Help ] [ Tool Help ]

The resulting Aspect grid should be computed and added to the display. Use identify to verify your hand
calculation for grid cell A and note the value of aspect for grid cell B.

Open the tool Spatial Analyst Tools = Hydrology = Flow Direction
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Use the identify button on the FlowDir and PercDrop grids that are created to verify that the numbers
correspond to the values you calculated by hand and resolve or reconcile any differences. Record in a
table the ArcGIS calculated flow direction and hydrologic slope (Output drop) at grid cells A and B.

To turn in: Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. Please
turn in a diagram or sketch that defines or indicates what each of these numbers means for the specific
values obtained for cells A and B.

1.3 Automating procedures using Modelbuilder.

Modelbuilder provides a convenient way to automate and combine together geoprocessing tools in
ArcToolbox. Here we will develop a Modelbuilder tool to automate the importing of the ASCII grid and
calculation of Slope, Aspect, Hydrologic Slope and Flow direction.

Right click on the whitespace within the ArcToolbox window and select Add Toolbox. Navigate to a
folder where you want to store your work (e.g. Ex3). In the opened window, click on the New Toolbox

icon and name it Ex3.tbx (or something else you might like). Click Open.
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Right-click on the new toolbox and select new model.
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The model window should open. This is a window where you can drag, drop and link tools in a visual way
much like constructing a flow chart.

In the Toolbox window browse to Conversion Tools = To Raster - ASCII to Raster. Drag this tool
onto the model window.

3 Model

Model  Edit  Insert  Miew \Windows Help
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Output raster

Double click on the ASCII to Raster rectangle to set this tool's inputs and outputs.



Input ASCII raster file ASCII to Raster

C:\Users\diarb\Scratch\Ex3lelev, bt
Output raster Converts an ASCIl file representing raster data to a raster dataset.

C:\Users\ditarb\ScratchiEx 3 ielevm. tif

Output data type (optional)
FLOAT

Set the Input ASCII raster file to elev.txt and Output raster to elevm.tif (I used elevm.tif so as not to
conflict with elev.tif that already exists). Set the output data type to be FLOAT. Click OK to dismiss this
dialog. Note that the model elements on the ModelBuilder palette are now colored indicating that their
inputs are complete.

.

ASCII to Raster

Locate the tool Spatial Analyst Tools = Hydrology = Flow Direction and drag it on to your window.
Your window should appear as follows.
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The output from the ASCII to raster function needs to be taken as input to the Flow Direction function. To

do this use the connection tool & and draw a line from elevm.tif, the Output raster of ASCII to Raster, to
Flow Direction. At the dialog that pops up select Input surface raster to indicate that elevm.tif is to be
used as the input Surface raster for the Flow Direction tool.
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Notice that the "output drop" oval is hollow. This is because this is an optional output that has not been
specified. Double click on the Flow Direction tool and specify names for both the Output flow direction
raster and optional Output drop raster.
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Click OK. Alternatively you could double click on output ovals individually to specify the output rasters.
The model is now ready to run. Run the model by clicking on the run button * .
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The orange boxes briefly flash red as each step is executed. The Model progress box opens and the
progress bar indicates when the model completes. You can then add the outputs to the map and examine
the results.

In the model, use the layout tool o to organize the layout.

Add the Spatial Analyst = Surface = Slope tool to your model by dragging it onto the model window.
Connect the elevm.tif output to this tool, specifying that it is the Input Raster for the Slope Tool.

St Input raster |

Environments  »

Precondition

Add the Spatial Analyst = Surface = Aspect tool to your model connecting it to elevm.tif as an input in
a similar way. Double click on the Slope and aspect tool outputs and specify file names for the outputs.
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When setting names you need to be careful that you do not use a name of a grid that already exists, or else
you will get a yellow warning sign in the display and the model will not run, as shown below:

utput raster
| C:Wsers'\dtarb\scratch'Ex3\Slope

Double click on the Slope tool and set the Output measurement to PERCENT_RISE. Your model should
appear as follows.

- — "
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e +BRx/92 > P aa@ il @O ksl P

m

< | Tl ol

You can click run and do all the processing required to import the data, compute Slope, Aspect, Flow
Direction and Hydrologic Slope at the click of a button. Pretty slick!

Right click on elev.txt and select Model Parameter.

v Mo ater
Add To Display

Right click on each of the outputs FlowDirm, percdropm, Slopem and Aspectm in turn and select Model
Parameter and Add to Display.
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dinfdirm tif Open..

Model Parameter

Managed

|| AddTo Display |

AN

A P now appears next to these elements in the diagram indicating that they are 'parameters' of the model
that may be adjusted at run time. Close your model and click Yes at the prompt to save it. Right click on
the model in the Toolbox window to rename it something you like (e.g. FlowDirection).

Right click on the whitespace within the ArcToolbox window and select Save Settings = To Default

€3 Add Teolbox...

‘;-5:\\: Environments...

Hide Locked Tools

| Save Settings ¥ To File...

Load Settings r To Default

This saves your toolbox settings so that your system remembers the tools you have loaded (in this case the
tool you have written in Ex3.tbx). This is useful if you want to not have to hunt for this Toolbox and load
it again if you exit from ArcGIS or if there is a crash. This applies to the specific computer you are using
so on a shared lab computer it is not really necessary and will not help if next time you work in the lab you
are at a different computer or the lab computer has been "refreshed" to its clean state.

If you go back to your model and now double click on it or Open it, you’ll see that the input files are
shown as parameters of the model just like when you execute a tool in ArcToolBox.
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1 C:\Users'dtarb\Scratch\Ex 3\flowdirm
Qpercdropm (optional)
C:\Users'\dtarb\Scratch\Ex 3 \percdropm
aslopem
I Ci\Users\dtarb\scratch\Ex 3\slopem
| @Aspectm
I C:\Users'dtarb\Scratch\Ex 3\aspectm
I c 4
| : ;
| [ Ok ] ’ Cancel ] ’Erwlronments. . ] ’ << Hide Help ] [ Tool Help

Where you see warnings or a red X Q near one of your files, it usually either means that there is already
a file of that name in the place where you propose to put the output or there is no input file. These can be
resolved by setting the inputs and outputs correctly.

You are done creating this model. Close ArcMap.

ModelBuilder is a very powerful way of creating complex analyses, and documenting your “workflow” in
a form that is visual and can readily be described. In this way, analyses that you’ve done can be passed on
to other analysts, and you can also use the visual palette display in your term project report or thesis to
document how you’ve done your analysis, so the visual aspect of the display helps with documenting your
work, as well as in organizing it.

To turnin: A screen capture of your final model builder model.

We will now use this model for different data. Reopen ArcMap. Locate the file demo.asc extracted from
the zip file of data for this exercise. Double click on your FlowDirection model in the Ex3 toolbox to run
it. If you omitted to save settings to default or are on a different computer you will need to add the Ex3
toolbox by right clicking within the toolbox area, selecting Add Toolbox and navigating to where your
Ex3.thx file is on disk. The following dialog box for the tool you created should appear when you open it.

%o FlowDirection I [E=FE )
Click amror and warning icons for more information lz‘ pe FlowDirection -
elev. et

C:\Users\dtarb\Scratch\Ex 3 \elewv. bt
aﬂowdirm
([ " -+
Ci\Users\dtarb\scratch\Ex 3\flowdirm

@percdropm (optional)

C:\Users'dtarb\scratch\Ex3\percdropm

Qslopem

I Ci\Users'\dtarb\Scratch\Ex 3 \slopem
I Qnspectrn

-+

Ci\Users\dtarb\scratch\Ex 3\aspectm

O ] ’ Cancel ] ’En\rironments... ] ’ << Hide Help ] [ Tool Help
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Select as input under elev.txt the file demo.asc. Specify different names for the outputs to avoid the

e .

conflicts with existing data and remove the red crosses

SD-J FlowDirection — =SRE X

elev. et “ | Aspectm

Ci\Users\dtarb\scratch\Ex3\demo.asc
flowdirm

C:\Users'dtarb\Scratch\Ex 3\demodir
percdropm (optional)

Ci\Users'\dtarb\Scratch\Ex3\demopercdrop
Slopem

C:\Users'dtarb\scratch\Ex 3idemoslope
Aspectm

C:\Users\dtarb\Scratch\Ex 3 \demoaspect

Mo description available

| 0K | | Cancel | |Environmenis... | | << Hide Help | | Tool Help |

Then click OK and the model should run and add results for this new data to ArcMap. Examine the
ArcMap table of contents and record the minimum and maximum values associated with each of the
outputs.

To turnin: A table giving the minimum and maximum values of each of the four outputs Slope, Aspect,
Flow Direction, and Hydrologic Slope (Percentage drop), for the digital elevation model in demo.asc.

Congratulations, you have just built a Model Builder geoprocessing program and used it to repeat your
work for a different (and larger) dataset. If you would like to save this tool to take to another computer or
share with someone else you can copy the file Ex3.tbx from its location to a removable media to take with
you. If you are going to be sharing this tool more widely there are additional steps to take to clean up the
interface (to avoid red X's), label the input fields and write help documentation for it.

Part 2. San Marcos Elevation and Precipitation.

The purpose of this part of the exercise is to calculate average watershed elevation for subwatersheds of
the San Marcos basin, and to calculate average precipitation over each of these subwatersheds using
different interpolation methods.

The following data is provided in the Ex3Data.zip file.
SanMarcos.gdb file Geodatabase.
= E B3
= ..:I SanMarcos
o BaseMap
[~ Flowline
(=] MenitoringPoint
- [51 BaseMapAlbers
(=7 PrecipStn
[E] Subwatershed
The feature classes Flowline and MonitoringPoint are from Exercise 2. There are two additional feature
classes:
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- PrecipStn. PrecipStn contains mean annual precipitation data from precipitation stations in and
around the San Marcos basin downloaded from NCDC following the procedures given in
http://www.ce.utexas.edu/prof/maidment/gradhydro2005/docs/ncdcdata.doc. This data was
prepared by downloading all years of available precipitation data for the counties in and around
the San Marcos basin, then averaging over these years, retaining only those stations with 6 or more
years of annual total data reported by NCDC.

- Subwatershed. Subwatersheds delineated to the outlet of the San Marcos Basin as well as each of
the stream gages in MonitoringPoint following the procedures that will be learned in a future
exercise.

These new feature classes are in a feature dataset named BaseMapAlbers as it is more sensible to do
watershed level analysis where area is involved in a projected coordinate system.

A digital elevation model from the National Elevation dataset is provided in the folder smdem_raw.

1. Loading the Data

Open ArcMap and from the geodatabase SanMarcos.gdb load the Basemap and BaseMapAlbers feature
datasets. Check the coordinate system of each by right clicking and selecting properties. Check the spatial
reference system of the data frame layers and if necessary set it to be the same as the BaseMapAlbers
feature dataset, "NAD_1983_Albers". We will use this specific NAD_1983_Albers projection, which is
the USA Contiguous Albers Equal Area Conic projection, for this exercise.

Add the grid smdem_raw to ArcMap. This is a digital elevation model that was downloaded from the
USGS seamless data server http://seamless.usgs.gov. Your map should look similar to the following:

'@ Untitled - ArcMap - Arclnt e

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

Ne2Eas SRS A E SPAl=I-1=1 1=l

BAQAMQ XLl @ |- K@ B MB ZDrawingr K ) El - A -7 [0) Al 10 vB I UA-H-2B. .
Table Of Contents 1 x ° -
EERELYE .

=] .

=] MonitoringPoint e °
*

=} PrecipStn
.
= Flowline
=2 Subwatershed
| "o
| =] smdem_raw
Value %
High : 618.485

Low :69.7852

[@a| & n < m )
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http://www.ce.utexas.edu/prof/maidment/gradhydro2005/docs/ncdcdata.doc
http://seamless.usgs.gov/

The DEM grid is skewed in this display because it was obtained in geographic coordinates. Right click on
the smdem_raw layer in the table of contents and select properties. Click on the source tab. This shows
you the Cell Size and number of columns and rows. If you scroll down in the properties you also see the
Extent and Spatial reference of this DEM.

Layer Properties l PRl

| General | Source | Extent | Display | Symbology

Property Value

=l Raster Information

m

Columns and Rows
Mumber of Bands
Cellsize (X, Y)
Uncompressed Size

4300, 2580

1

0.00027777778, 0.00027777773
47.24MB

GRID
continuous

Format
Source Type
Pixel Type
Pixel Depth

floating point
32 Bit -

Data Source

Data Type:
Folder:
Raster:

File System Raster »
Ci\Users\dtarb\ScratchEx 3}

smdem_raw

I Set Data Source... I

[ ok ][ Comcel || oph

The cell size is in degrees. This is not a very useful measure at this scale. Use what you learned in the
lecture on Geodesy, Map Projections and Coordinate systems to calculate the cell size in m in both the E-
W and N-S directions, assuming a spherical earth with radius 6370 km. Do this for a location at the center
of this DEM.

To turnin: The number of columns and rows, cell size in the E-W and N-S directions in m, extent (in
degrees) and spatial reference information for the San Marcos elevation dataset DEM ‘smdem_raw'.

2. Projecting the DEM.

To perform slope and contributing area calculations we need to work with this DEM projected into the
Albers equal area projection (An equal area projection is most appropriate for area calculations such as we
will be performing). Open the Toolbox and open the tool Data Management Tools 2 Projections and
Transformations = Raster = Project Raster. Set the inputs as follows:
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Input Raster Project Raster

l I smdem_raw
Input Coordinate System (optional) Transforms the raster dataset from one projection to another.
[ GCs_north_american_1983
Qutput Raster Dataset
C:\Users\ditarb\Scratch\Ex 3 smdem I
Output Coordinate System
USA_Contiguous_albers_Equal_Area_Conic

Geographic Transformation {optional)

Resampling Techingue (optional)
CUBIC

OQutput Cell Size {optional)
100

Registration Point (optional)
¥ Coordinate Y Coordinate

-

| [ cancel | [Environments... | [ <<tidetielp | [ ToolHep |

The output coordinate system should be specified using Select a predefined coordinate system ... after
clicking on the button to the right of Output coordinate system. Then browse to the USA Contiguous
Albers Equal Area Conic projection in the Projected Coordinate Systems\Continental\North America
folder.

Browse for Coordinate Systen

[E Morth America *l 1 @ LE| ;

i} Morth America Equidistant Conic.prj

i Morth Arnerica Lambert Conformal Conic.ptj

(. US Mational Atlas Equal Area.prj

A 58 Contiguous Albers Equal &rea Conic.prj

(. USA Contiguous Albers Equal Area Conic USGS.prj
(o US8 Contiquous Equidistant Canic.pri

(.} USA Contiguous Lambert Conformal Conic.prj
WG S 1984 Canada Atlas LCC.prj

Mame: 11598 Contiguous Albers Equal Area Conic,pri

Show of tvper | coordinate Systems '] [ Cancel
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The cell size should be specified as 100 m and CUBIC interpolation used. | have found cubic
interpolation to be preferable to nearest neighbor interpolation for continuous datasets such as DEMs.
(This NED data is at 1 arc second spacing which is close to 30 m, so in general 30 m would be a better
choice here, but 100 m is chosen to reduce the size of the resulting grid and speed data processing and
analysis.) CUBIC refers to the cubic convolution method that determines the new cell value by fitting a
smooth curve through the surrounding points. This works best for a continuous surface like topography at
limiting artificial "striping" that can appear in a shaded relief map (we will construct a shaded relief map
below) with the other methods. Click "OK" to invoke the tool. After the process is complete, the projected
DEM, smdem, is added to ArcMap.

Examine the properties of the projected dataset.

To turn in: The number of columns and rows in the projected DEM. The minimum and maximum
elevations in the projected DEM. Explain why the minimum and maximum elevations are different from
the minimum and maximum elevations in the original DEM.

3. Exploring the DEM

The spatial information about the DEM can be found by right clicking on the smdem layer, then clicking
on Properties>Source. Similarly, the symbology of the DEM can be changed by right clicking on the
layer, Properties=>Symbology.

| General | Source I E xtent I Display| Symbology |

Shi: stretch values along a color ramp _
Unique Yalues Import. ..
Classified

»

Stretched
Discreke Colar

Calor Value Label Labeling

e 818.193  High: 618,193

m

698373 Low: 69,8373

[ Display Background Yalue: i asD R
[ Use hillshade effect 1 Display NoData as([_ |
Stretch
Tvpe: [Standard Deviations v] Histograms
ni 2 [ 1rveert

[] apply Gamma Stretch: 1

Ok ][ Cancel l[ Apply
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.
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L. Warp

[ — | 3]

L Comvinct Conedinatn Mot

[@a| 2o«

I

-199956.188 -797693.65 Meters

m

To explore the highest elevation areas in your DEM select Spatial Analyst Tools > Map Algebra >
Raster Calculator.

- By Density
-8 Distance

&5 Local

%: Extraction
& Generalization
%: Groundwater
%: Hydrology
% Interpolation

- Spatial Analyst Tools
& Conditicnal

EI&; Map Algebra

L AW Raster Calculator

Double click on the layer smdem with the DEM for San Marcos. Click on the “>” symbol and select a
number less than the maximum elevation. This arithmetic raster operation will select all cells with values
above the defined threshold. In the example below a threshold of 600m was used.
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Raster Calculator o[

& Map Algebra expression Map Algebra expression

Layers and variables Conditional —  « The Map Algebra expression you

< smdem @ want to run.
<>smdem_raw B B[E i
E B m The expression is composed by
specifying the inputs, values,
EBE B operators, and tools to use. You
can type in the expression directly
0 B E[ﬂ@ or use the buttons and controls to

help you create it.

"smdem” > 600

o The Layers and variables
list identifies the datasets
Output raster available to use i_n the Map
Algebra expression.
C:\Users\dtarb\Documents\ArcGIS\Default. gdb\raster The buttons are used to
enter numerical values and
operators into the
expression. The ( and )
buttons can be used to
apply parentheses to the
expression.
A list of commaonly used
tools is provided for you.

-

| [Envirorments... | [ <<ridetiep | [ Toolhep |

A new layer called raster appears on your map. The majority of the map (grey color in the figure below)
has a 0 value representing false (values below the threshold), and the blue region has a value of 1
representing true (elevations higher than 600 meters).
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Zoom in to the region of highest elevations (red region) and do some sampling on the smdem grid using

the identify ﬂ tool or pixel inspector & to identify the grid cell of maximum elevation. Use the draw
tools to mark your point of maximum elevation and label it with the elevation value for that pixel.

TN

To turnin: A layout showing the location of the highest elevation value in the San Marcos DEM. Include
a scale bar and north arrow in the layout.

4. Contours and Hillshade

Contours are a useful way to visualize topography. Select Spatial Analyst Tools - Surface - Contour.
Select the inputs as follows:

r -
’E% Contour =R X
Input raster i Contour
|5mdem j ]
Output polyline features Cre?tes a _Ilmla_ featufl;e class th
contours (isolines) from a raster
C:\Users'dtarb\scratch\Ex 3\ Contours. shp suface ( )
Contour interval -
10
Base contour {optional)
1]
Z factor (optional)
1
0K ‘ I Cancel ‘ IEn\rironments... ‘ I << Hide Help ‘ I Tool Help
=

A layer is generated with the topographic contours for San Marcos. Notice the big difference in Terrain
Relief to the west of the basin compared to the east. This results from the fact that the Balcones fault zone
runs through the middle of this basin, to the west of which lies the rolling Texas hill country and to the east
the flatter coastal plain. There is a tower located in the City of San Marcos on which you can stand and
see these differences in topography to east and west!
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Another option to provide a nice visualization of topography is Hillshading.

Select Spatial Analyst Tools - Surface - Hillshade and set the factor Z to a higher value to get a
dramatic effect and leave the other parameters at their defaults (the following hillshade is produced with a
Z factor of 10). Click OK. You should see an illuminated hillshaded view of the topography.
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To turn in: A layout with a depiction of topography either with elevation, contour or hillshade in nice
colors. Include the streams from the San Marcos Basemap Flowline feature class and sub-watersheds from
the Sub-Watersheds feature class.

5. Zonal Average Calculations

In hydrology it is often necessary to obtain average properties over watersheds or subwatersheds. The
Zonal functions in Spatial Analyst are useful for this purpose.

Select Spatial Analyst - Zonal > Zonal Statistics as Table. Set the inputs as follows:

Input raster or feature zone data Zonal Statistics as Table

I Subwatershed

Zone field
HydroID
Input value raster

Summarizes the values of a raster
within the zones of another dataset
and reports the results to a table.

I smdem
Qutput table
Ci\Users\dtarb\Scratch\Ex3\zoneeley

lgnore NoData in calculations {optional)

Statistics type (optional)
ALL

Click OK. A table with zonal statistics is evaluated.
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T.;I-%-%Fj .ﬁl

zoneelev

:

HYDROID | COUNT RANGE
330 | 25077 | 250765980 | 133.76616 | 270.45315 | 136.72704 | 185.91457 | 25163082 5522148
33| 92118 | 921160000 | 243.33472 | 614.74020 | 371.41487 | 413.63503 | 80.418663 | 38563082
332 | 14516 | 145160000 | 150.04472 | 355.79966 | 205.75456 | 268.64362 | 4058317 | 4305408
333 | 12865 | 128660000 | 173.83481 | 388.71356 | 21487875 | 265.02551 | 43.514744 | 33882125
334 | 15086 | 150860000 | 117.32205 | 19527524 | 77.953186 | 150.15849 | 15645368 | 2866685.3
335 | 33042 | 330420000 | 101.34137 | 214.44771 | 11210824 | 15208874 | 25456076 | S0SS052.5
336 | 958025 | 980245580 | 99.17285 | 408.08511 | 308.91623 | 183.51825 | 51.008335 | 17985376
337 | 27802 | 272020000 | 85.388283 | 202.97105 | 117.58277 | 131.47083 | 20671431 | 36551463
338 | 26157 | 261570000 | 75.940525 | 188.10834 | 11216781 | 115.34716 | 17.080147 | 30171358

o4 1 » » E (0 out of 9 Selected)
zoneeley

C=RE-1 AR R AR ]

This contains statistics of the value raster, in this case elevation from smdem over the zones defined by the
polygon feature class Subwatershed. The Value field in this zone table contains the HydrolD from the
subwatershed layer and may be used to join these values with attributes of the Subwatershed feature class.

Right click on Subwatershed and select Joins and Relates - Join.

o v CEyEEen | | B% Math |
O 5

Copy
ChUsers\dtarb\S) % Remove
t —
L] contours E Open Attribute Table T Lk el
C\Users\dtarbs|___Joins and Relates vl Jein..
hillshade ',_I/ Zoom To Layer Remove Jein(s) »
Value
High : 254 Relate...
Visible Scale Range 4 Remove Relate(s) »

Select HydrolD as the field to base the join on and zoneelev as the table to join.

("Join Data ‘ (5 S |

Join lets you append additional data to this layer's attribute table so you can,
for example, symbalize the layer's features using this data.

What do you want to join to this layer?

[Join attributes from a table hd

-

. Choose the field in this layer that the join will be based on:

HydroID -

[

. Choose the table to join to this layer, or load the table from disk:

I zoneelev j @

Show the attribute tables of layers in this list

w

. Choose the field in the table to base the join on:
M
Join Options

@ Keep all records

All records in the target table are shown in the resulting table.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

() Keep only matching records

If a record in the target table doesn't have a match in the join
table, that record is removed from the resulting target table.

Walidate Join
About Joining Data
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At the prompt to build an index click Yes.

A N
Create Index ﬁ

The join field in the join table you are joining to the target is not indexed.

‘Would you like to automatically create an index for the join figld in the join table
now? Doing so will significantly improve performance.

[ Yes ] [ No ] [ Cancel

[] Use my cheice and do not show this dislog again

e S ————— e e——— A

It would not really matter if you clicked No as this table is sufficiently small that the presence of indices to
speed up the data queries does not make any noticeable difference.

Open the Subwatershed attribute table. Under table options select Export and specify a dbf file for the
output.

] =

H Find & Replace...

Bl Select By Attributes... Export: [Allrecords v]

T

Use the same coordinate system as:

this layer's source data

E¥  Switch Selection

E
[f] SelectAll £ the data frame
. ﬂ the feature dataset you export the data into H
Add Field... £ (only applies if you export to a feature datasetin a geodatabase) I
Turn All Fields On E|l| outputtable: |
m| H
Show Field Aliases L[| C\Users'dia\Scratch\Ex3\Export_Outputldbf & |
L
Arrange Tables ' I I
Restore Default Column Widths | |
Restore Default Field Order E
| [ QK J ’ Cancel ]
Joins and Relates 3
Related Tables 3
il Create Gragh...

Add Table to Layout
Reload Cache

@k

Print...
Reports »
| Export... |

You do not need to add the exported dbf file to the map. The exported dbf file can be opened in Excel to
examine and present the results. Determine the mean elevation and elevation range of each subwatershed
in the SanMarcos Subwatershed feature class.

25



To turnin: A table giving the HydrolD, Name, mean elevation, and elevation range for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
elevation? Which subwatershed has the largest elevation range?

6. Calculation of Area Average Precipitation using Thiessen Polygons

Now to do something really useful. We will calculate the area average mean annual precipitation over the
watershed using Thiessen polygons. Thiessen polygons associate each point in a watershed with the
nearest raingage. Select the tool Analysis Tools = Proximity = Create Thiessen Polygons
- & Analysis Tools

+ @ Exfract

+ & Overlay

- & Proximity

A Buffer

Specify PrecipStn as the Input Features. Set the output feature class to be ThiessenP (saving it in the
BaseMapAlbers feature dataset) and indicate that ALL fields should be output. Click OK.

* Create Thiessen Polygons E‘@|E|
Input Features Create Thiessen %
|Precipstn = = Polygons
Qukput Feature Class . )
|C:'|,Dave'|,5cratch'l,ExS'l,SanMarcos.gdb'l,BaseMap.ﬂlbers'l,TheissenF‘ = E:L?tr:]\ruinfge:?uprzt Cplglsnstsu}n an
Qutput Figlds {optional) Thisssen proximal
|'°"-L ﬂ polygons.

v

[al'4 | Cancel | Envirnnments...| <= Hide Help | Tool Help

The result is a Thiessen polygon shapefile.

ks

To average precipitation values in these polygons over the subwatersheds we need to convert this to a grid.
Select the tool Conversion Tools 2 To Raster > Features to Raster.
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EI& To Raster
i ..... ASCH to Raster
- DEM to Raster

----- ﬁ Feature to Raster

ar

Specify the Input feature as ThiessenP, field as AnnPrecip_in (it is the annual rainfall that we would like
to work with), output raster as thiessen and cell size as 100 m. Click OK.

Input features Feature to Raster

I ThiessenP
Field
AnnPrecip_in
Output raster
C:\Users'dtarb\scratch\Ex 3\ Thiessen
Output cell size {optional)
100

Converts features to a raster
dataset.

—

| [Environments... | [ <<tidetep | [ Toolhep |

The result should be a grid that gives in each cell the annual precipitation value from the corresponding
Thiessen polygon.

Select Spatial Analyst > Zonal - Zonal Statistics as Table. Set the inputs as follows:
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' N
= — = X
\ Zonal Statistics a< Table — :

=

Input raster or feature zone data Zonal Statistics as Table
Subwatershed ﬂ
Zone field Symmarizes the values of a raster
HydraID - within the zones of another dataset
fsiivE o ey and reports the results to a table.
|Thiessen j
Output table
C:\Users'\dtarb\Scratch\Ex 3\zonetheiss

lgnore NoData in calculations {optional)

Statistics type (optional)
ALL -

’ QK ] ’ Cancel ] [Envircnments... ] ’ << Hide Help ] [ Tool Help ]

Click OK. A table with zonal statistics is created. This contains statistics of the value raster, in this case
mean annual precipitation from thiessen over the zones defined by the polygon feature class
Subwatershed. The HydrolD in this table may be used to join it to the attribute table for the
Subwatershed feature class. As for the elevations above this joined table can be exported and examined
and presented in Excel.

To turnin: A table giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

7. Estimate basin average mean annual precipitation using Spatial Interpolation/Surface
fitting.

Thiessen polygons were effectively a way of defining a field based on discrete data, by associating with
each point the precipitation at the nearest gage. This is probably the simplest and least sophisticated form
of spatial interpolation. ArcGIS provides other spatial interpolation capabilities in the Interpolation
toolbox in Spatial Analyst Tools.

- a Spatial Analysk Tools

+ % Conditional

+ % Density

+ % Distance

+ % Extraction

+- 8% Generalization

+ % Groundwater

+ % Hydralogy

=] % Inkerpalation
A oW
A Kriging
A Matural Meighbor
A opline
2 spline with Barriers
}" Topo to Raster
& Topo to Raster by File

& Trend

S P

We will not, in this exercise, concern ourselves too much with the theory behind each of these methods.
You should however be aware that there is a lot of statistical theory on the subject of interpolation, which
is an active area of research. This theory should be considered before practical use of these methods.
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Select Spatial Analyst Tools = Interpolation = Spline. Use the input points from "PrecipStn" and Z
value field as " AnnPrecip_in", and set the spline type as Tension with default parameters as follows:

‘% Spline g EF.)E- |

- -

Input point features Spline

IPrecipStn LI @

Interpolates a raster surface from

Z value field : ! ) .
AnrPredp_in - points using a two—dmgnsmnal
Output raster minimum curvature spline
l Ci\Users'\dtarb\Soratch\Ex 3\spline @ technique.
@iipiEE ISER(a ] The resulting smooth surface
100 @ passes exactly through the input
Spline type (optional) points.
TEMSION -
Weight (optional)
0.1
I Mumber of points (optional)
12
CK ] ’ Cancel ] [En\rironments... ] ’ << Hide Help ] [ Tool Help

The result is illustrated:

Use Zonal Statistics as Table as before to determine the mean precipitation for each subwatershed in the
SanMarcos Subwatershed feature class from the tension spline interpolation.

To turnin: A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for
each subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest
mean precipitation using a Tension Spline interpolation?

Experiment with some (at least one) of the other methods available (Natural Neighbor, Kriging, Inverse
distance weighting) to see if you like them.
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To turn in. A layout giving a nicely colored map of the interpolated mean annual precipitation surface
over the San Marcos Basin for one of the methods used and a table showing the mean annual precipitation
for the same method in each Subwatershed. Report what method you used.

8. Runoff Coefficients.

Runoff ratio, defined as the fraction of precipitation that becomes streamflow at a subbasin outlet is a
useful measure in quantifying the hydrology of a watershed. Mathematically runoff ratio is defined as

w =Q/P

where Q is streamflow, and P is precipitation. In this formula, P and Q need to be in consistent units such
as depth per unit area or volume. In exercise 2 we analyzed the average streamflow at the eight monitoring
points in the San Marcos watershed. The flow field in the Monitoring point dataset gives this data, in ft*/s.
To convert these to volume units (say ft) they should be multiplied by the number of seconds in a year (60
X 60 x 24 x 365.25). In the current exercise mean annual precipitation has been evaluated for each
subwatershed, in inches. To convert these to volume units (say ft®) these quantities should be multiplied
by 1/12 ft in™ and multiplied by the subwatershed area in ft*. The subwatershed feature class includes
subwatershed area, in the units of the spatial reference frame being used, which are m. (Remember, 1 ft =
0.3048 m). The necessary calculations are most easily performed in Excel. Use the Options/Export
function to export the subwatershed featureclass attribute table that includes your Thiessen basin average
subwatershed precipitation results to dbf format that can be read by Excel, as was done above. Similarly
export the Monitoring Point featureclass attribute table that includes mean annual streamflow at each
monitoring point. In Excel multiply gage streamflow by 60 x 60 x 24 x 365.25 to obtain streamflow
volume, Q, in ft®. Multiply subwatershed average precipitation (in inches) by subwatershed area (in
m?)/(12 x 0.3048°) to obtain subwatershed precipitation volume, P, in ft>. On the maps you have that show
subwatersheds and streams identify the subwatersheds upstream of each gauge. Do this visually by
looking at the Flowlines. Add up the precipitation volumes over these subwatersheds then divide Q/P to
obtain an estimate of runoff ratio for the watershed upstream of each stream gage.

To turn in. A table giving runoff ratio for the watershed upstream of each stream gage.

Summary of Items to turn in:
1. Hand calculations of slope at point A using each of the two methods and comments on the differences.

2. Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. Please turn in a
diagram or sketch that defines or indicates what each of these numbers means for the specific values
obtained for cells A and B.

3. A screen capture of your final model builder model.

4. A table giving the minimum and maximum values of each of the four outputs Slope, Aspect, Flow
Direction, and Hydrologic Slope (Percentage drop), for the digital elevation model in demo.asc.

5. The number of columns and rows, cell size in the E-W and N-S directions in m, extent (in degrees) and
spatial reference information for the San Marcos elevation dataset DEM 'smdem_raw'.

6. The number of columns and rows in the projected DEM. The minimum and maximum elevations in the

projected DEM. Explain why the minimum and maximum elevations are different from the minimum and
maximum elevations in the original DEM.
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7. A layout showing the location of the highest elevation value in the San Marcos DEM. Include a scale
bar and north arrow in the layout.

8. A layout with a depiction of topography either with elevation, contour or hillshade in nice colors.
Include the streams from the San Marcos Basemap Flowline feature class and sub-watersheds from the
Sub-Watersheds feature class.

9. Atable giving the HydrolD, Name, mean elevation, and elevation range for each subwatershed in the
SanMarcos Subwatershed feature class. Which subwatershed has the highest mean elevation? Which
subwatershed has the largest elevation range?

10. Atable giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

11. A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation using a Tension Spline interpolation?

12. A layout giving a nicely colored map of the interpolated mean annual precipitation surface over the
San Marcos Basin for one of the methods used and a table showing the mean annual precipitation for the
same method in each Subwatershed. Report what method you used.

13. A table giving runoff ratio for the watershed upstream of each stream gage.
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